
Quick Start Guide 

WICED 

MMPWICED-QSG203-R

5300 California Avenue • Irvine, CA 92617 • Phone: 949-926-5000 • Fax: 949-926-5203 January 15, 2014

S

WICED™ Development System

 



Broadcom®, the pulse logo, WICED™, Connecting everything®, and the Connecting everything logo are 
among the trademarks of Broadcom Corporation and/or its affiliates in the United States, certain other 

countries and/or the EU. Any other trademarks or trade names mentioned are the property of their respective 
owners.

Broadcom Corporation
5300 California Avenue

Irvine, CA 92617

© 2014 by Broadcom Corporation
All rights reserved

Printed in the U.S.A.

Revision History

Revision Date Change Description

MMPWICED-QSG203-R 01/15/14 Updated:
Converted to Broadcom template

MMPWICED-QSG202-R 04/19/13 Updates for WICED-SDK-2.3.0
MMPWICED-QSG201-R 12/14/12 Updates for WICED-SDK-2.2.0
MMPWICED-QSG200-R 11/22/12 Released
MMPWICED-QSG200-D1 09/26/12 Updates for WICED-SDK-2.0
MMPWICED-QSG102-R 12/23/11 Include notes for integrated WICED™ IDE
MMPWICED-QSG101-R 11/09/11 Release with instructions for SDK Installer
MMPWICED-QSG101-D4 11/02/11 Draft 4 release for WICED-SDK-1.1
MMPWICED-QSG100-R 06/02/11 Initial release



Table of ContentsWICED Quick Start Guide

Broadcom®  
January 15, 2014 • MMPWICED-QSG203-R Page 3

 

Table of Contents

About This Document .................................................................................................................................. 5

Acronyms and Abbreviations................................................................................................................... 5

Document Conventions........................................................................................................................... 5

References.............................................................................................................................................. 6

Technical Support ........................................................................................................................................ 6

WICED Development System ...................................................................................................................... 7

Evaluation Board..................................................................................................................................... 7

Software Development Kit....................................................................................................................... 7

Directory Structure .................................................................................................................................. 8

Hardware and Software Requirements ............................................................................................ 8

Setting Up the WICED SDK.......................................................................................................................... 9

Instructions for Windows® XP / Windows® 7 ....................................................................................... 10

Install the WICED SDK and IDE .................................................................................................... 10

Connect the WICED Evaluation Board .......................................................................................... 10

Verifying Driver Installation ............................................................................................................ 11

Troubleshooting ..................................................................................................................... 11

Instructions for Mac OS X ..................................................................................................................... 12

Install the WICED SDK and IDE .................................................................................................... 12

Connect the WICED Evaluation Board .......................................................................................... 12

Using the WICED IDE ................................................................................................................................. 13

Build and Download a Sample Application............................................................................................ 13

Run an Application ................................................................................................................................ 16

Debug an Application ............................................................................................................................ 16

What Now?............................................................................................................................................ 18

Appendix A: Configuring a Terminal Application .......................................................... 19
Set Up PuTTY for Windows ....................................................................................................................... 19

Set Up CoolTerm for OS X ......................................................................................................................... 21

Appendix B: WICED IDE Hints & Tips ............................................................................. 23
Hints............................................................................................................................................................. 23

Shortcuts..................................................................................................................................................... 23

Appendix C: Importing the WICED SDK into Eclipse..................................................... 24
Importing the WICED SDK into Eclipse.................................................................................................... 24

Setup Instructions to Build and Download Applications ........................................................................ 24

Preparation..................................................................................................................................... 24

Build ............................................................................................................................................... 25

Setup Instructions for Application Debugging ....................................................................................... 27



List of FiguresWICED Quick Start Guide

Broadcom®  
January 15, 2014 • MMPWICED-QSG203-R Page 4

 

List of Figures
Figure 1: WICED Evaluation Board with BCM943362WCD4 WICED Module................................................... 7

Figure 2: Wiced SDK Windows Setup ............................................................................................................. 10

Figure 3: WICED SDK OS X Setup ................................................................................................................. 12

Figure 4: The WICED Integrated Development Environment .......................................................................... 13

Figure 5: Eclipse - Apps/snip/scan.c Source Plus the Results of a JTAG Download ...................................... 26

Figure 6: Eclipse - Debugging the Apps/snip/scan.c Application..................................................................... 28



About This Document

Broadcom®  

January 15, 2014 • MMPWICED-QSG203-R Page 5

WICED Quick Start Guide

 

About This Document
This document provides detailed instructions to set up the Broadcom® Wireless Internet Connectivity for 
Embedded Devices (WICED™; pronounced "wicked") development system. 

The WICED development system supports application development using a WICED evaluation board. The 
development system is compatible with Windows®, Mac OS X and Linux. This document describes the software 
components included in the WICED development system and provides instructions for compiling WICED 
sample applications in Windows® and OS X using the WICED integrated development environment (IDE).

The instructions in this document must be completed before the WICED SDK and WICED evaluation board can 
be used.

This document is for software developers who are using the WICED Development System to create applications 
for secure embedded wireless networked devices.

Acronyms and Abbreviations
In most cases, acronyms and abbreviations are defined on first use. For a comprehensive list of acronyms and 
other terms used in Broadcom documents, go to:
http://www.broadcom.com/press/glossary.php.

Document Conventions
The following conventions may be used in this document:

Note: This document applies to WICED SDK 2.3.0.

Convention Description

Bold User input and actions: for example, type exit, click OK, press Alt+C
Monospace Code: #include <iostream>

HTML: <td rowspan = 3>
Command line commands and parameters: wl [-l] <command>

< > Placeholders for required elements: enter your <username> or wl <command>
[ ] Indicates optional command-line parameters: wl [-l]

Indicates bit and byte ranges (inclusive): [0:3] or [7:0]

http://www.broadcom.com/press/glossary.php
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References
The references in this section may be used in conjunction with this document.

For Broadcom documents, replace the “xx” in the document number with the largest number available in the 
repository to ensure that you have the most current version of the document.

Technical Support
Broadcom provides customer access to a wide range of information, including technical documentation, 
schematic diagrams, product bill of materials, PCB layout information, and software updates through its 
customer support portal. For a CSP account, contact your Broadcom Sales or Engineering support 
representative.

General WICED support is available on the Broadcom forum at the URL shown below. After signing up to the 
forum, please apply to be a member of the WICED users group and identify yourself to the forum moderator. 
Access to the WICED forum is restricted to bona-fide WICED customers only.

http://forum.broadcom.com/forum.php

Note: Broadcom provides customer access to technical documentation and software through its 
Customer Support Portal (CSP) and Downloads and Support site (see Technical Support).

Document (or Item) Name Number Source

Broadcom Items

[1] WICED™ Evaluation Board User Guide WICED-EUM2xx-R WICED Website

http://forum.broadcom.com/forum.php
http://www.broadcom.com/products/wiced/
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WICED Development System
The WICED development system is composed of a WICED evaluation board, the WICED software development 
kit (SDK) and the WICED Integrated Development Environment (IDE).

Evaluation Board
The Broadcom® WICED evaluation board (Figure 1) incorporates a WICED module and circuitry to enable the 
programming and debugging of applications on the module.

Figure 1:  WICED Evaluation Board with BCM943362WCD4 WICED Module

Software Development Kit
The WICED SDK includes:

• WICED software development tools:

– Utilities and OS drivers to support development in the Windows® environment

– WICED software stack, development tools and demonstration applications

– ThreadX and FreeRTOS Real-Time Operating Systems (RTOS), and NetX/NetXDuo IPv4/IPv6 and 
LwIP IPv4 TCP/IP network stack implementations.

– Embedded security libraries including TLS & HTTPS

– A WICED Wi-Fi driver and API

– WICED Application Framework (WAF)

– Manufacturing test and Iperf applications to enable system performance testing

• WICED API Documentation, this guide, and related documents
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Directory Structure
Table 1 is an overview of the top-level directory of the WICED SDK.

Hardware and Software Requirements
• The WICED SDK runs on 32- and 64-bit versions of Microsoft Windows® XP and Win7, Mac OS X 10.5 or 

later, and 32/64-bit Linux.

• The SDK is distributed as a standalone 7zip zipfile suitable for all operating systems, and bundled together 
with the WICED Integrated Development Environment as an executable installer. The installer is only 
provided for Windows® and OS X operating systems.

• The development computer requires a single USB port to connect to the WICED evaluation board. 

• A terminal emulation application such as PuTTY (Windows®) or CoolTerm (OS X).

Table 1:  Overview of the WICED SDK Top-Level Directory

WICED-SDK Directories Directory Contents

Apps Demo applications and snippets, test utilities, and WAF components

Doc API Documentation, Reference Documentation, Schematics

Drivers Windows USB Drivers for the WICED evaluation board

Include WICED API function prototypes, constants, and defaults

Include/platforms Platform description and I/O definitions

Library Daemons, servers, protocols, and peripheral libraries

Resources Resources used by the WICED webserver incl. HTML, images, styles, etc.

Tools Toolchain including compiler, debugger, and other utilities/scripts

Wiced WICED core components: RTOS, TCP stack, Security & Platform definitions

Wiced/WWD The WICED Wi-Fi Driver

Note: The 7zip extraction utility is available from 7-zip.org. 7zip is needed if you plan to extract the 
standalone WICED SDK 7zip archive. The standard Windows zipfile extraction utility may silently 
corrupt the SDK archive during the extraction process. Do not use it.
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Setting Up the WICED SDK
The WICED SDK is available for download from the Broadcom® WICED website or from the Broadcom® 
Customer Support Portal.

To use the SDK, the following steps must be performed:

1. Download and install the WICED SDK and IDE

2. Choose and compile an application

3. Load the application into the WICED module on the WICED evaluation board

4. Run the application

5. Debug the application

This section provides instructions for Step 1 for Windows® and Mac OS X. Steps 2-5 are discussed in Section 4.

Note: Do not plug the WICED Evaluation Board into the development computer prior to installing the 
WICED Development System. Doing so may cause the incorrect driver to load.
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Instructions for Windows® XP / Windows® 7

Install the WICED SDK and IDE

The WICED SDK is provided as a self-installing executable file. Double-click the Wiced-SDK-2.3.x-IDE-
Installer.exe file to begin the installation. A setup window similar to Figure 2 displays.

Figure 2:  Wiced SDK Windows Setup

Choose the installation folder for the WICED IDE and click Next, then choose the installation workspace folder 
for the WICED SDK and click Install. Once the installation completes, click Finish to immediately start the 
WICED IDE, or deselect the Start WICED IDE now options and click Finish to exit.

Connect the WICED Evaluation Board

The USB interface connects the WICED evaluation board to the PC. The USB interface provides +5V power as 
well as individual programming/debug and UART interfaces to the microcontroller on the WICED module. A 
separate +5V power supply is not required.

The WICED evaluation board has two logical USB devices: a USB-JTAG device and a USB-UART device. A 
driver for the WICED evaluation board was automatically installed during the SDK installation process.

Plug the WICED evaluation board into the development PC with a USB cable, the driver automatically loads.
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Verifying Driver Installation

To verify that driver installation has completed successfully, do the following: 

1. Open the Device Manager (right-click My Compute and select Properties).

2. In the System Properties window, select Hardware and then Device Manager. 

a. The WICED USB Serial Port is listed under MY-LAPTOP\Ports (COM & LPT, shaded yellow).

b. The WICED USB JTAG Port is listed under MY-LAPTOP\WICED USB JTAG Devices (shaded blue). 

The Device Manager window identifies the WICED USB Serial COM port as COM21. The assigned port 
number varies between systems.

Troubleshooting

If an error occurs during the automatic driver installation process, the driver may be manually installed from the 
<WICED-SDK>\Drivers directory.

If the WICED evaluation board still does not appear in the Device Manager, verify the 3V3 LED is turned ON 
and/or replace the USB cable.
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Instructions for Mac OS X

Install the WICED SDK and IDE

The WICED SDK is provided as an OS X package installer. Double-click the Wiced-SDK-2.3.x.pkg file to begin 
the installation. A setup window similar to Figure 3 displays.

Figure 3:  WICED SDK OS X Setup

Click Continue once to read the welcome note, then click Continue again and select installation permissions. 
After installation permissions are selected, click Continue and then click Install. Enter your account password 
if asked, and follow the prompts to complete the installation.

Connect the WICED Evaluation Board

The USB interface connects the WICED evaluation board to the Mac. The USB interface provides +5V power 
as well as individual programming/debug and UART interfaces to the microcontroller on the WICED module. A 
separate +5V power supply is not required.

The WICED evaluation board has two logical USB devices: a USB-JTAG device and a USB-UART device. A 
driver for the WICED evaluation board is included with the OS X operating system.

Plug the WICED evaluation board into the Mac with a USB cable, the driver automatically loads. Verify the 
WICED evaluation board 3V3 LED is ON indicating the board is powered. If the LED is not on, replace the USB 
cable and try again.
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Using the WICED IDE

Build and Download a Sample Application
On a Windows PC, start the WICED IDE by selecting START, All Programs, Broadcom, and then WICED IDE. 
On a Mac running OS X, use the Finder application to locate Applications, the WICED directory, and then 
double-click the WICED IDE shortcut. After startup, the WICED IDE looks similar to Figure 4.

Figure 4:  The WICED Integrated Development Environment

The Help tab to the right of the WICED IDE window describes how to build and download the sample 
applications shown in the Make Target tab (located above the Help tab). Multiple build targets are pre-configured 
for a number of sample applications and at least two WICED hardware platforms including 'BCM943362WCD4' 
and 'BCM9WCDUSI09'. 

For this example, we will build and download the 'ping' application for the 'BCM943362WCD4' WICED module 
on the WICED Evaluation Board. If the module on your evaluation board is different, follow the instructions to 
modify or copy one of the 'ping' build targets to match your hardware platform.

Double-click the snip.ping-BCM943362WCD4 target to build the ping application; the IDE console window 
displays the build progress. The build target is appended with the 'download' and 'run' options, these options tell 
the toolchain to download the firmware and run the application after the build completes.
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The build output looks similar to the following:

**** Build of configuration Default for project Wiced-SDK ****
"C:\My Documents\Wiced-SDK\make.exe" snip.ping-BCM943362WCD4 download run 
Applying changes made to: Wiced/Wiced.mk
******************************************************************************** 
The target Wi-Fi MAC address is defined in <Wiced-SDK>/generated_mac_address.txt 
Ensure each target device has a unique address!                                  
******************************************************************************** 
Building Bootloader
Building App
Making .gdbinit
Making DCT image
Compiling App_Ping
Compiling Platform_BCM943362WCD4
Compiling ThreadX
Compiling NetX_Duo
Compiling Wiced
Compiling Lib_http_server
Compiling Lib_Gedday
Compiling STM32F2xx
Compiling WWD_ThreadX_Interface
Compiling Wiced_ThreadX_Interface
Compiling WWD_NetX_Duo_Interface
Compiling Wiced_NetX_Interface
Compiling Supplicant_uSSL
Compiling Lib_dns_redirect_daemon
Compiling Lib_dns
Compiling WWD_for_SDIO_ThreadX
Compiling Supplicant_wps_brcm
Compiling SPI_Flash_Library_BCM943362WCD4
Compiling Lib_dhcp_server
Compiling Wiced_Wifi_image
Making snip_ping-BCM943362WCD4.elf
Making snip_ping-BCM943362WCD4.bin
Build complete

snip_ping-BCM943362WCD4
----------------------------------|---------|---------|
                                  |         |  Static |
              Module              |  Flash  |   RAM   |
----------------------------------+---------+---------|
App                               |    7778 |    1012 |
Bootloader                        |     133 |       0 |
dhcp_server                       |    1111 |       0 |
dns                               |    3028 |      44 |
Gedday                            |    4942 |     721 |
http_server                       |    1175 |       0 |
libc                              |   50186 |    2632 |
Networking                        |    3719 |   29320 |
NetX                              |   52818 |     644 |
NetX-Duo - Interfaces & Stacks    |       0 |    5896 |
Platform                          |     786 |       0 |
RAM Initialisation                |    2464 |       0 |
Startup Stack & Link Script fill  |     475 |     844 |
STM32 library                     |    9736 |    2602 |
Supplicant - SSL/TLS              |   59894 |     424 |
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ThreadX                           |   11692 |    1604 |
Wi-Fi Firmware                    |  189776 |       0 |
Wiced                             |    2161 |     750 |
WWD                               |   13346 |    1035 |
----------------------------------+---------+---------|
TOTAL (bytes)                     |  415872 |   47532 |
----------------------------------|---------|---------|
Downloading Bootloader ...
Download complete 
Downloading Application ...
Download complete 
Downloading DCT ...
Download complete 
Resetting target
Target running

During firmware download, a blue LED labeled 'JTAG' on the WICED evaluation board illuminates to indicate 
that a JTAG firmware download is in progress. 

If the WICED evaluation board is not recognized by the programming tools, it may be necessary to disconnect 
and then reconnect the board to the computer before trying again. The following message indicates there was 
an error with the download process: 

"**** OpenOCD failed - ensure you have installed the driver from the drivers directory, and that the 
debugger is not running **** In Linux this may be due to USB access permissions. In a virtual machine 
it may be due to USB passthrough settings ****"
Resetting target
make: *** [run] Error 1



Using the WICED IDE

Broadcom®  

January 15, 2014 • MMPWICED-QSG203-R Page 16

WICED Quick Start Guide

 

Run an Application
This section assumes you have successfully completed “Build and Download a Sample Application” on page 13, 
and the ping application is running on the WICED module.

Several methods are available to verify the ping application is working. After power-on-reset, the ping 
application prints status messages to the USB UART of the WICED evaluation board.

To verify printing, follow the instructions in Appendix A: “Configuring a Terminal Application,” on page 19 to 
setup a terminal application such as PuTTY (Windows) or CoolTerm (OS X). Start the terminal application and 
connect to the WICED evaluation board then press the reset button on the board. The following text displays:

Platform BCM943362WCD4 initialised
Started ThreadX v5.5
Initialising NetX v5.6
Creating Packet pools
Starting Wiced v2.3.0
Joining : YOUR_AP_SSID
Successfully joined : YOUR_AP_SSID
Obtaining IPv4 address via DHCP
Setting IPv6 link-local address
IPv4 network ready IP: 192.168.1.100
Pinging 192.168.1.1 every 1000ms with a 900ms timeout.
Ping Reply : 3 ms
Ping reply : 1 ms
...

Debug an Application
The WICED development system supports single-step thread-aware interactive application debugging with the 
WICED IDE. Brief instructions to start debugging an application are provided in the WICED IDE Help tab. The 
following example demonstrates how to start debugging the 'ping' application.

1. Setup a breakpoint:

a. Using the Project Explorer tab on the left of the IDE, navigate to the 'WICED-SDK/Apps/snip/ping' 
directory. Double-click on 'ping.c' to open the source file in the WICED IDE editor window.

b. Scroll to the 'application_start' function and locate the call to 'wiced_init' (at approximately line 180).

c. Double-click in the column to the left of the 'wiced_init' function to place a break point at this function 
(alternately right-click in the column and select 'Toggle Breakpoint'). A green dot appears in the column.

2. Setup the 'ping' debug build target: In the WICED IDE Make Target tab, right click on the 'ping-
BCM943362WCD4 download run' build target and click Edit (alternately, copy-paste and then edit a new 
build target). Change the build target to 'ping-BCM943362WCD4-debug download'.

3. Build and download the debug firmware image: Double-click the newly created 'ping' debug target, the 
debug firmware image builds and downloads to the 'BCM943362WCD4' module on the WICED evaluation 
board.

Note: A description of the ping application is provided in the header comments of the ping.c source 
file located in the WICED SDK at <WICED-SDK>/Apps/snip/ping/ping.c.
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4. Launch the debugger: Click the green bug icon on the WICED IDE toolbar (or press F11 on Windows® 
systems). The debugger starts. If the WICED IDE displays a Confirm Perspective Switch dialogue box, click 
Yes to show the debug view.

To confirm the debugger is running, verify the blue JTAG LED on the WICED evaluation board is flashing, 
and that the WICED IDE looks similar to the following screen capture.

5. Run to a breakpoint: To run the application to the 'wiced_init' breakpoint configured in Step 1, click the yellow/
green pause/play button in the Debug tab. The Debug tab control buttons are highlighted in yellow in the 
following screen capture.
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6. View a breakpoint: When the debugger halts at a breakpoint, the WICED IDE does not automatically switch 
to the current thread as the context for the debugger. It is necessary to manually check the current task in 
the running thread is selected before analyzing debug information.

To find the breakpoint, click on the 'application_start()' function under Thread[2] in the Debug tab. The 
'ping.c' source file opens and the wiced_init function is highlighted in green to show where the program 
halted.

7. Step program execution: Step Into, Step Over and Step Return options are available in the WICED IDE Run 
menu. Alternately, Step shortcut icons are provided in the Debug tab, and on Windows® Systems, by 
pressing F5, F6 and F7, respectively.

8. Stop debugging: To stop debugging, click the square red stop button in the Debug tab.

What Now?
Now you have a basic understanding of how to compile, download and debug a WICED application, we 
recommend that you try to build and run each of the snippet and demo applications provided in the WICED SDK 
Applications directory. 

Each snippet application provides a relatively simple example demonstrating how to use a particular API or 
feature of the WICED SDK. The more sophisticated demo applications combine multiple APIs and features to 
demonstrate advanced functionality.

To help you use the WICED IDE, Appendix B contains some quick hints and tips that will save you time 
navigating around the WICED code base. Read these now, then move onto trying WICED applications.

Note: If the debugger fails to launch, it may be necessary to terminate an existing debug process. On 
Windows®, press Ctrl-Alt-Delete to open the Windows® Task Manager, then select the Processes tab. 
Search for, and terminate, all 'arm-none-eabi-gdb' processes.



Configuring a Terminal Application

Broadcom®  

January 15, 2014 • MMPWICED-QSG203-R Page 19

WICED Quick Start Guide

 

Appendix  A:  Conf iguring  a  Terminal  
Appl icat ion

The following instructions describe how to obtain and install a serial terminal application for use on computers 
running a Windows or OS X operations system. Broadcom recommends using PuTTY for Windows systems 
and CoolTerm for OS X systems, however other equivalent applications may work equally well. 

Ensure the WICED Development System is already installed on the computer, then plug the WICED evaluation 
board into the computer using a USB cable before continuing.

Set Up PuTTY for Windows
PuTTY is available as a free download from http://putty.org. Download and install PuTTY.

The following procedure describes how to establish a UART serial interface between PuTTY and the WICED 
evaluation board.

1. Start the PuTTY application. The PuTTY Configuration window opens. Set the configuration options as 
follows:

• Category: Serial

• Serial line to connect to: type in the COM port that was assigned after the USB and serial port drivers 
were installed. Refer to Step 2(a) in Section 3.1.3. 

• Speed (baud): 115200

• Data bits: 8

• Stop bits: 1

• Parity: None

• Flow control: None

http://putty.org
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2. In the Category pane, select Session.

3. Under the Connection type, select the Serial option then click Open.

4. A blank terminal window opens with the selected COM port specified in the window title. If the specified COM 
port is incorrect or unavailable, PuTTY displays an error message as shown in the following screen capture. 
If this happens, verify the correct COM port has been selected and try again.

5. Assuming the ping application is running on the WICED evaluation board, press the reset button on the 
board to view application prints during the boot and run process.
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Set Up CoolTerm for OS X
CoolTerm is available as a free download from http://freeware.the-meiers.org/CoolTermMac.zip. Download and 
install CoolTerm.

The following procedure describes how to establish a UART serial interface between CoolTerm and the WICED 
evaluation board.

1. Start the CoolTerm application and click the Options menu icon. The CoolTerm Configuration window 
opens. Set the Serial Port configuration options as follows:

• Port: usbserial-XXXXXXXX

• Baudrate: 115200

• Data bits: 8

• Parity: none

• Stop bits: 1

• Flow control: Deselect all options

2. Click OK.

3. Click the Connect menu icon. The CoolTerm application connects to the WICED evaluation board.
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4. Assuming the ping application is running on the WICED evaluation board, press the reset button on the 
board to view application prints during the boot and run process.
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Appendix  B:  WICED IDE Hints  & Tips

Hints
• The Help tab (and any other tab) may be click-dragged to any window pane if desired to customize the IDE 

layout.

• To revert to the C/C++ perspective (rather than the Debug perspective), click the C/C++ icon in the top-right 
corner of the window.

Shortcuts
A useful cheat-sheet outlining short cuts for the WICED IDE (Eclipse) is included in the <WICED-IDE>/Readme 
directory or on online here.

Particularly useful keystrokes are listed below.

• General search: to search the WICED-SDK tree for 'my_variable':

a. Left-click the root WICED-SDK folder in the Project Explorer pane

b. Press Strl+H (on Windows)

c. Enter the text 'my_variable' into the File Search tab (regular expressions work as well)

d. Click Search

• Search for a 'c' source element (variable, function, enum, etc.):

a. Open a 'c' source file eg. <WICED-SDK>/Apps/snip/ping/ping.c

b. Press Ctrl+Shift+T

c. Start typing an element (e.g., 'wiced_time_')

d. Suggestions appear in the popup window

• Navigation/Edit History:

– To return to the previous file, press Ctrl+Left (arrow)

– To return to the previous file, press Ctrl+Right (arrow)

http://www.cheat-sheets.org/saved-copy/eclipseCDT8.0-cheatsheet.pdf
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Appendix  C:  Import ing the WICED SDK into 
Ec l ipse

This advanced section is only for customers that must import the WICED SDK into an existing version of Eclipse. 
Instructions in this guide apply to the Juno release of Eclipse CDT. The guide is tailored to a Windows 
installation, but may be used as a reference for other operating systems.

Broadcom provides a WICED IDE installer that automatically performs all of the following steps and configures 
the WICED SDK development environment for you. Before continuing, please strongly consider using the 
WICED IDE installer instead.

The following instructions assume a Broadcom WICED BCM943362WCD4 evaluation board is plugged into 
your computer, and that you have installed drivers for the board. Drivers are provided in the WICED-SDK/Drivers 
directory.

Importing the WICED SDK into Eclipse
Eclipse CDT (C/C++ Development Tooling) provides a fully functional C/C++ Integrated Development 
Environment based on the Eclipse platform. Complete details are available at http://eclipse.org/cdt/.

Setup Instructions to Build and Download Applications
This subsection contains the procedure to set up Eclipse to build and download an application using the WICED 
development system target: snip.scan-BCM943362WCD4-debug

Preparation
1. Eclipse uses a workspace to manage projects: create a workspace directory and copy the extracted WICED 

development system directory to it. 

2. Download and install the Juno version of Eclipse CDT from http://eclipse.org/cdt/downloads.php.

3. Launch Eclipse.

Note: Broadcom does not provide direct customer support for Eclipse setup. Usage and setup 
instructions are provided as a helpful guide.

Note: Eclipse is a self-contained package based on Java®. It does not use the standard Windows 
installation procedure; instead, it runs directly from the directory into which it has been extracted. If 
your development PC does not already have an installation of Java, go to http://java.com to obtain and 
install Java before installing Eclipse.

http://eclipse.org/cdt/downloads.php
http://eclipse.org/cdt/
http://eclipse.org/cdt/
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Build
1. In the Eclipse Workspace Launcher window, enter the workspace directory, click OK, and wait for the main 

Eclipse program window to open. If a splash screen tab is displayed, close it by selecting X in the upper-left 
corner. 

2. From the File menu, select New Makefile Project with Existing Code.

3. In the Import Existing Code window, click Browse and navigate to the WICED-SDK directory. 

4. Click Finish; the WICED-SDK appears in the Eclipse Project Explorer pane on the LEFT of the screen.

5. In the Eclipse program window, in the RIGHT pane, at the top next to the Outline tab, select the Make Target 
tab (green bull's eye icon) 

6. Right-click on the WICED-SDK root directory name, and then, from the shortcut menu, select New. 

7. In the Create Make Target | Target Name field, type the following:

snip.scan-BCM943362WCD4-debug download run

8. Click OK to dismiss the window.

9. In the Make Target tab:

a. Left-click the Open Folder icon.

b. Left-click the arrow next to WICED-SDK to view the target that was just created.

10. Double-click the newly created scan make target. The scan application compiles and downloads to the 
WICED evaluation board. Progress is shown in the Console tab, in the lower window pane. 

Figure 5 shows an example of the Eclipse program window with the Apps/snip/scan.c source together with the 
results of a JTAG download session in the console window.
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Figure 5:  Eclipse - Apps/snip/scan.c Source Plus the Results of a JTAG Download
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Setup Instructions for Application Debugging
To enable hardware debugging, it is necessary to install an additional Eclipse CDT component. The following 
instructions detail the necessary steps: 

1. From the Help menu, select Install New Software, and then click the Available Software Sites link.

2. Click Add:

a. In the Add Site window, in the Name field, type JunoCDT.

b. In the Location field, type http://download.eclipse.org/tools/cdt/releases/juno and then click OK.

c. In the Preferences window, from the Available Software Sites list, locate the JunoCDT site, verify that it 
is selected, and then click OK.

3. In the Work with list:

a. Select JunoCDT, wait for the CDT features to update, and then click the arrow to expand the CDT 
Optional Features list.

b. Select the C/C++ GDB Hardware Debugging option and then click Next twice.

c. Accept the license agreement (click Accept) and then click Finish to install the hardware debugger. 
Eclipse will restart when installation is complete.

4. After Eclipse restarts, in the Project Explorer pane (left side of the Eclipse window), click to select the 
WICED-SDK-2.3.0 directory structure.

5. From the Run menu select Debug Configurations.

a. In the Debug Configurations window, double-click GDB Hardware Debugging to automatically create a 
submenu item named Wiced-SDK-2.3.0 Default.

b. In the C/C++ Application field, type: build/eclipse_debug/last_built.elf 

c. Select the Disable auto build option.

6. On the Debugger tab:

a. Use the Browse button next to the GDB Command field to locate the gdb application <WICED-SDK-
2.3.0>\Tools\ARM_GNU\bin\Win32\arm-none-eabi-gdb.exe to the GDB Command text.

b. From the JTAG Device list, select Generic TCP/IP.

c. In the Hostname or IP address field, type: localhost

d. In the Port Number field, type: 3333

e. Select Force thread list update on suspend.

7. On the Startup tab:

a. In the Initialization Commands panel, clear the Reset and Delay (seconds) option, add the following text 
in the text pane:

add-symbol-file build/eclipse_debug/last_bootloader.elf 0x8000000

b. In the Load Image and Symbols panel, clear the Load image option.

c. In the Run Commands pane, type: stepi

8. On the Common tab, select the Debug option, click Apply, and then click Close.

9. In the Eclipse main window, open the list attached to the green bug icon

a. Click Wiced-SDK-2-2.0 Default.

b. In the Confirm Perspective Switch window, click Yes.



Importing the WICED SDK into Eclipse

Broadcom®  

January 15, 2014 • MMPWICED-QSG203-R Page 28

WICED Quick Start Guide

 

To verify that the debugger is running correctly, confirm that the following line of source code is highlighted 
green:

__asm__( "   ldr r1, =link_stack_end\n"

The blue JTAG LED on the WICED evaluation board flashes each time the debugger communicates with the 
WICED module (for example, when single-stepping through code).

With the debugger running, the Eclipse window looks similar to Figure 6

Figure 6:  Eclipse - Debugging the Apps/snip/scan.c Application
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